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Introduction 

 

Welcome in documentation for Oxatis’s Sage 200c 2018 connector.  

The connector is the tool that will allow data to be exchanged between your website and your 

commercial management software Sage 200c. 

The different features will be shown in the proper order of use, starting from configuration. Will be 

then presented the 3 wizards: article importation, customer importation, and order exportation. A 

last chapter will deal with most advanced features of the connector needing a particular attention, 

given the complexity or the number of the possible cases that could be met.  

The first two chapters are dealing with a presentation of the new features and general information 

about the connector.  

We wish you a good reading, a good discovery, and a good daily use of this tool.  

Oxatis’s collaborators are at your disposal to help you, especially through online support in your back-

office. 

 

Oxatis’s team 
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1. General information on the connector 

 

• The DataPlug is the software dedicated to the importation of items, users and orders between 

an Oxatis e-commerce website and local files (.csv, .xml, .jpg…). The technology used to 

communicate between Oxatis’s platform is called “WebServices”. 

• The Sage 200c connector is the connector proposed by Oxatis in order to automate the link 

between products, customers and orders directly with the Sage Database 

• Installation softwares for the connectors and user guides are downloadable from the menu 

“Online Help” under the “?” menu in the back-office. They are also accessible from the 

following URL:  

http://www.oxatis.com/Help/HelpCenter.asp?ActionID=512&LangID=1 

 

• A setup and update guide is presented on the next chapter. 

 

 Advices are shown with this blue icon. 
 

 

 
Elements that particularly require your attention are shown with this orange icon. 
  

http://www.oxatis.com/Help/HelpCenter.asp?ActionID=512&LangID=1
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2. Setup, update and backup 

This chapter presents how to install the DataPlug and the Connector step by step. 

Installation 
 

• To install Oxatis DataPlug, Microsoft .net Framework 4.0 is required. 

 

• To activate the DataPlug Link for Sage 200c, the following is required: 

✓ Installation of Sage 200c 2018 – On Premise software with valid activation keys. 

✓ OR Installation of Sage 200c 2018 – Online software with valid activation keys. 

 

 

• Launch the DataPlug’s setup software « OxatisDataPlugSetupEN.msi »: 

✓ Accept the licence agreement 

✓ Select the install folder 

✓ Choose if the DataPlug has to be installed only on the current windows session (“Only me”), or every session on 

this computer. 

 

In order to share the database and change users more easily, it is preferable to choose:  

- One remote desktop session with the setup set as “only me”. This session can then be used alternatively by the users that 

have access to this session. It allows the DataPlug to continue to work in the background and continue the automation of 

data exchange 24/7 thanks to the scheduler, as long as the session is not stopped. 

- One computer, shared with an installation for “everyone”, allowing different Windows session to access the DataPlug on 

this computer. 

 

• A shortcut is automatically created on the desktop. 

 

• During the first installation, it is advised to right click on the DataPlug to “open as an administrator”, from the Windows 

program list or the program’s folder (for example: C:\Program Files (x86)\Oxatis\DataPlug) 
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Update 
 

• In “Tools > settings” of the DataPlug, an option allows you to check if an update is available: 

 

 

• If the option is activated, an icon will appear, meaning that an update is available, or else it is still possible to check 

manually in “Tools > Check for Oxatis DataPlug Updates”: 

 

• Clicking on the DataPlug icon will update the software automatically to the latest available 

version.  

 

Once the new version is installed, it is advised to use the different importation wizards to check the different 

configuration parameters and discover the default values for the new available features.  

Selection and activation of the “task scheduler” is also advised. 

Backup 
 

It is important to periodically save a database from the menu “Tools > DataPlug database > Backup”. 

 

 The folder C:\ProgramData\Oxatis contains the database, and the user’s preferences should also be included in the 

company’s data saving plan. 

 

Note the different importation parameters for the Products and the users, as well as the exportation for orders. The update 

can make some fields change, due to the arrival of new features. 
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3. Configuration 

On Premise Version 
 
In the DataPlug, select the Connectors | Link for Sage 200c | Configuration menu. 

 

 
 

In the window below from the DataPlug, you will have to configure the following: 

• Active company, 

 
 

The “Connection Test” button checks the installation and the communication with the software: Sage 200c 2018- On Premise. 

 

It is possible that the CashOrder Account is not filled in Sage 200c 

In this case it is necessary to fill in the following field: 

Sales Order Processing > SOP Utilities > System Set Up > SOP Settings > Default Accounts 

Allow cash orders to be taken, using this account 
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Online Version 
In the DataPlug, select the Connectors | Link for Sage 200c | Configuration menu. Log in with your Sage 200c information. 

 

 
 

In the window below back in the DataPlug, you will have to configure the following: 

• Active company, 

 
 

The “Connection Test” button checks the installation and the communication with the software: Sage 200c - Online. 
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4. Creating Products, Images and Customers in Sage 200c 2018 

We have created various products and a customer for a new company in the Sage 200c 2018 On Premise software. 

 

• Products 
 

Below is a list of products created in Sage 200c 2018. 
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Below is an example of the details of the product “COOK/CERM/HOB” in Sage 200c 2018 On Premise: 
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Below is an example of the locations for the product “COOK/CERM/HOB” in Sage 200c 2018 On Premise: 

 
Below is an example of the attachments for the product “COOK/CERM/HOB” in Sage 200c 2018 On Premise: 

It is possible to attach images on a product (format: png, jpg, bmp and gif) 
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• Customers 
 

We have also created a customer with the following content in Sage 200c 2018 On Premise: 
 

Company customer details: 

 

Main customer details: 
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Customer delivery address: 

 

 

 It is possible to unlock the “Country” and “County” fields. For this, it is needed to check the box “Use segmented 

addresses” in the menu: “Configuration Settings > Accounting system > System settings” 
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5. Importing Products, Images and Categories from Sage to DataPlug 

• The Link for Sage 200c 2018 allows you to import products that meet the following criteria to your website: 

✓ “Publish to web” is set to true (in “Web” tab of product file in Sage 200c 2018) 

✓ The used VAT rate exists on the Oxatis website 

✓ Product code length is less than or equal to 20 characters 

 

• Below are the Oxatis fields that are automatically mapped by the Link for Sage 200c 2018 On Premise: 

 

Oxatis Sage 200c 2018 On Premise 
Code Code 
Name Name 
Quantity in Stock In Stock or Free stock 
VAT Rate Tax value associated to tax code 
Description Item description 
Price 1 Sales Price 

Weight 
Weight  
Note: weight in website will be expressed in 
grams 

Zoom Image Image (Web Defaults | Custom Fields) 
Main Image Image (Web Defaults | Custom Fields) 
Thumbnail image Image (Web Defaults | Custom Fields) 
Category 1 Product group 
Cost Unit Cost Price 

 

• Importing products to the DataPlug: 

 
Click on the following menu in the DataPlug: Connectors | Link for Sage 200c | Import Items from Sage 200c to 

DataPlug.   
You will then be guided through the configuration of the data to import. 
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1st step: You can select: 

• A warehouse. 

• Possibility to choose between Free Stock or In Stock. Both terms are defined as follows in the Sage 

documentation: 

o Free stock= 

In stock – Allocated stock  

 

o In stock= 

Allocated stock + Free Stock  

 

• For BOM products, it is possible to display the composed product and associated quantity.  

 

 
 

Consequently, the “Bill of material products” will be displayed as simple products in the Oxatis Website.  
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2nd step: You can select: 

• A range of products groups. 

• A range of item codes. 

• A range of suppliers 

• You can decide to ignore Items with an “Inactive” state 

• You can decide to ignore items whose stock is unavailable 

 
 

3 rd step: For each of the 10 Oxatis prices of the item, you can define the matching price in Sage 200c. It is not possible to 
import prices in another currency than the one defined for the Oxatis website.  
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4 th step (exclusive to the EXTRA version): Options: 
In order to import the options, you need to first check the box allowing their activation. 4 fields are available: 
Oxatis Parent Item Code: This field defines which “search category” holds the code of the parent article for the products with 
options. 
Oxatis 1st Option: Defines the prefix allowing the connector to get the first option.  (Ex: OX_Option1_Electric) 
Oxatis 2st Option: Defines the prefix allowing the connector to get the second option 
Oxatis 3st Option: Defines the prefix allowing the connector to get the third option 
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 Link for Sage 200c 2018 
Version 8.70 

6 novembre 2019 

 

Page 19 / 64 

Creating Search Categories in Sage 200c 
Creation of Search categories can be made in the “Stock Control > Stock Maintenance > Search Categories” menu. 

 

 
It is necessary to create as many Search Categories as your website will have options. 
 
Once the creation of the search categories has been done, it is necessary to connect them to the product groups. This 
action can be made in “Stock Control > Stock Maintenance > Product Groups”. You need to edit the product group to add 
the search category. 
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In the “searching” tab, add every search category you need to link to this article. 
 

 
 
On the article view, Analysis tab, it is now possible to fill the search values for the specific product. 
On this example, for the child product “COOK/CERM/HOB”, there are 2 options: 

- Options1_Fuel, which has the value “electric” 
- Options2_Electrical, which has the value “hob” 
- The parent product of this article will be “COOK” 

It is necessary to repeat this operation for every child article of the “COOK” article. 
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5th step (exclusive to the EXTRA version): Three categories are available to associate product categories (Oxatis). You can: 
 

• Create an Oxatis tree-structure for the categories from the “Product Group” and search categories. 

• Find the category name (Sage) inside the category tree (Oxatis) 
 
Example: If an article has a “Hob” category (on Sage) and is in a subcategory “Cooking/Hob” on your Oxatis website, you can 
check this box and the product will be put in the corresponding Oxatis’s subcategory. 
 
It is possible to skip this step, in order to associate later the 3 products categories with other information from the article 
view. 
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6th step (Exclusive to the Extra version):  - Oxatis’s website allows the final customer to filter the products with some 
technical characteristics. This navigation is also made possible thanks to some information on the Product view. 

 
In order to import them, it is necessary to check the box “Import characteristics”. 

• For every search category (Sage 200c), it is possible to associate one or more characteristic form your Oxatis 
website, which will be shown on the Article level. 

• It is possible to define if the characteristics values have to be translated on the website. 
For example, for a characteristic “colour”, and a value “red”, it will be necessary to translate the value “Red” for the 
different languages your website uses. 
The translation has to be made in the “Commerce > Option types” menu. Choose the correct characteristic, modify it and 
change the values in the “Edition language” column. 
 
 
For the value of the characteristics that have to be translated, it is necessary for the characteristic to have already been 
imported in the site’s main language. 
 
 
The “public name of an option type” can be translated without problem, as the DataPlug uses mainly the internal name of 
the characteristic. 
 
 

 
 

 
It is possible to import several characteristics per search category (Sage). In order to achieve this, you only need to separate 
every characteristic’s value by the separator defined during the product transfer. By default, it is the semicolon “;”. 
If a value is null, it won’t be imported. 
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7th step: In this step, all the fields of the Oxatis item - that are not automatically associated by the connector - are proposed 
in order to be associated manually to Sage 200c fields and Search categories. 
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8 th step: Images attached to every article in Sage 200c (attachments tab) can be sent to your Oxatis website 
 
Several possibilities: 

• No image importation 

• Images named like: “Item Code_1, Item Code_2…, Item Code_10” 

• The first 10 available images from the (Sage) item attachment list 
 

It is also possible to reset all additional images already attached to an article. 
 

The box “Assign a category” will group the imported images in an image category. 
 

 
 

 
 

With the option “Image Named like: Item Code_1, Item Code_10”, the “item Code_1” image will be defined as main image. 
Consequently, it is necessary to have an image marked as “_1” 
 
 

 
To have the image import wizard it is necessary that the first item to be imported have images 
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9 th step: It is possible to rename images. 
 

 
 
10 th step: The image format can be kept or automatically adapted to the site’s dimensions. It its quality is high enough, the 
same image can be used to generate the main image, thumbnail image and zoom image at once. 
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Last step: The importation of products from Sage 200c 2018 On Premise is complete. The number of products that were 

imported or updated in the DataPlug database is displayed in the results. By clicking on the “Finish” button, all of the import 

settings (product selection criteria) are saved. 
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6. Preview of the Products imported from Sage 200c 2018 On Premise  

Once the products have been imported from Sage 200c 2018 On Premise, the main screen of the DataPlug is refreshed and 

displays the number of products imported or updated in the DataPlug’s database.   

 

You can view this data in the View | Products menu before uploading them to your Oxatis website.  

 
 

Preview of the “General” tab in the product list. 
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Preview of the “Prices” tab in the product list.   

 
 

Preview of the “Categories” tab in the product list. 
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7. Importing Customers 

1. The DataPlug Link for Sage 200c 2018 On Premise allows you to import customers and contacts, provided that they contain 

an email address.  

 

2. Below are the Oxatis fields that are automatically mapped by the Link for Sage 200c 2018: 

Oxatis Sage 200c 2018 On Premise 
Last Name Last name 
First Name First name 
Email Email 
Company Company name 
VAT Reg No VAT Number 
Phone Telephone 
Secondary Phone Mobile 
Fax Fax 
Address Address 
Postal Code Post Code 
Shipping Address Address Line 1 + Address Line 2 (Delivery 

address) 
Postal Code(Shipping Address) Post Code (Delivery address) 
Country (Shipping Address) Country Code (Delivery address) 
Phone (Shipping Address) Telephone (Delivery address) 
Discount Invoice Discount % 
  

 

3. Importing customers: 

 

Click on the following menu in the DataPlug: Connectors | Link for Sage 200c | Import Customer Account from 
Sage 200c to DataPlug.   

You will then be guided through the configuration of the data to import. 
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1st step: You can select: 

• A different range of: 

- Contact Last names. 

- Default Email 

- Contact Role Name 

- Customer Account Number 

 

• A Customer Account Code, who will be the Sage 200c customer gathering all the B2C contacts. Indeed, any new 

B2C contact will be added to this customer.  

 
 

 
 
This B2C Customer Account must be in the currency defined on the Oxatis website. (Which is displayed in brackets as a 
reminder) 
 

 
 
This B2C customer account is automatically retrieved from Sage 200c 

The client is displayed: 

Sales Order Processing > SOP Utilities > System Set Up > SOP Settings > Default Accounts 

Allow cash orders to be taken, using this account 
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2nd step: You can select the following options: 

• Import Line Discount 

• Import Discount for Product group and discount for Stock Item 

• Automatically map the Oxatis Price and the Customer Price (Sage) 

• A choice for importing shipping addresses 

• Account balance threshold limit before the customer moves from customer in account to cash customer 

If Credit limit > (balance + informed number) the customer moves from customer in account to cash customer 

 

 
 

Final step: In this step, all fields from the Oxatis users – that are not automatically mapped by the connector – are proposed 

in order to be associated manually to Sage fields.
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Last step: The import of customers from Sage 200c 2018 is complete. The number of customers that were imported or 

updated in the DataPlug database is displayed in the results. By clicking on the “Finish” button, all of the import settings 

(customer selection criteria) are saved.  

 

 
  



 Link for Sage 200c 2018 
Version 8.70 

6 novembre 2019 

 

Page 33 / 64 

8. Previewing Customers Imported from Sage 200c 2018 On Premise   

Once users have been imported from Sage 200c 2018 On Premise, the main screen of the DataPlug is refreshed and displays 

the number of customers or users imported or updated in the DataPlug’s database.   

 

You can view this data in the View | Users menu before uploading it to your Oxatis website.  

 
Preview of the “Main Information” tab in the user list of the DataPlug. 

Note: You will find the Sage 200c 2018 On Premise “customer code” in the “customer reference” field.  

 
 

Preview of the Address tab in the user list of the DataPlug. 
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9. Uploading Data (Images, Products and Users) to Oxatis 

Data from Sage 200c 2018 On Premise can be uploaded from the DataPlug to Oxatis separately (Products, Images, Users) or 
all at once from the DataPlug menu: Upload | All. 

 

 
 

The total number of records (Images, Products and Users) to be uploaded to Oxatis is displayed before the data is 

uploaded.  

 
Click on “Next” to upload the data to the Oxatis website. 

You can cancel the upload at any time and send the remaining data at a later date.  

 

Once the upload is complete, the number of records (Images, Products and Users) that were uploaded to the Oxatis site will 

be displayed.  
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10. Viewing Data Uploaded to the Oxatis Webite 

CUSTOMERS/USERS: Log in to the Oxatis website and click on the following menu to see the customers/users uploaded 

from the DataPlug: Marketing | Users  

 

Below is a preview of the uploaded users. 

 
 
PRODUCT CATEGORIES: To see the product categories created during the upload, click on the Commerce | Categories 
menu.  
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PRODUCTS: To see the products created during the upload, click on the Commerce | Items menu.    
 
Below is the detailed product information for product code “COOK/CERM/HOB”: 

Main information: Prices, Product Code, EAN Code, Name… 

 
 

Product Quantity in Stock and Low stock Level 
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Product Weight 

 
 

Product Categories  

 
 

Product Characteristics
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11. Example: 2 Orders placed on the Oxatis website 

Two orders have been placed on the website to be downloaded to the DataPlug. 

The first order (No. 15102899) has been billed excluding VAT, the second order (No. 15102964) has been billed including 

VAT.  

 

Below is a preview of the orders placed on the Oxatis site 
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Below is a preview of the order including VAT and a global discount of 10%.   
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Below is a preview of the order excluding VAT, including discounted individual products, and a global discount of 10%  
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12. Downloading Orders from the Oxatis website to the DataPlug  

This involves downloading - or importing - customer orders from the Oxatis website and saving them in the DataPlug’s 
database.   

 
Click on the following menu in the DataPlug: Download | Orders. 
You will be guided through the configuration of the customer orders to download.  
 

 
1st step: By default, the current day is proposed in the date range. However, you can select another date range.  
Note: Only orders with a confirmed payment status are downloaded. However, you can select another payment status 
(Contacting Payment Processor, Payment in Process, or Payment Refused), as well as the date range related to the change 
of the payment status.  
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2nd step: The number of orders to download is displayed. Click on the “Next” button to download the customer orders to the 
DataPlug. 

 
Once the download is complete, the number of orders that were downloaded into the DataPlug’s database will be displayed.  
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13. Viewing Orders Downloaded to the DataPlug  

Once orders have been downloaded from Oxatis, the main screen of the DataPlug is refreshed and displays the number of 

orders (2) downloaded to the DataPlug’s database.   
 

You can view this data in the View | Orders menu before exporting them to Sage 200c 2018 On Premise.  

 
Below is a preview of the “Total” tab for the order selected from the list.  

 
Below is a preview of the “Order Details” tab, where all products for the selected order can be found. 
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14. Export Customer Orders to Sage 200c 2018 

Exporting orders from Oxatis to Sage 200c 2018 On Premise entails creating new sales orders in the company’s Sage 200c 
2018 On Premise.  
 

In the DataPlug, click on the menu: Connectors | Link for Sage 200c | Export Orders from DataPlug to Sage 200c 
You will be guided through the necessary configurations to export your orders. 

 
 

1st step: By default, the DataPlug proposes to export all orders that have not yet been exported to Sage 200c 2018 On 

Premise.  

However, you can select a date range, with the option to export orders that have already been exported. 
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2nd step: You should select the following parameters: 

• The selected warehouse will be linked to the new orders to import in the Sage database. By default, 

it is the one connected during the products importation. 

• Oxatis’s payment methods must be associated to the payment methods filled in Sage. (Oxatis’s 

“generic” payment methods will be associated with Sage’s “other” payment methods) 

or it is possible to associate no payment to the order 

• The user code holding every B2C customer is here for your information. It is the one filled during user 

importation. 

• The Sage 200c “Customer document No” field prefix. This is not mandatory. 

• One analysis code to contain the source mapping 

 

 
 

 

 
 
It is only possible to export orders whose items are in the same warehouse. Indeed, if an order contains 2 products from 2 
different warehouse, no order will be exported. 
 

 
 
Reminder: The B2C customer account must have the same currency between Sage 200c and the Oxatis website. The Oxatis 
currency is displayed is brackets.  
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3rd step: You have to associate a shipping option from Oxatis to an additional charge in Sage 200c, where you charge the 

shipping costs.  
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4rd step: You have to link VAT rates for local, EU and export.  

 

Last step:  The number of orders to export is displayed. Click on the “Next” button to export the customer orders to the Sage 

200c 2018 On Premise. 
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Once the export is complete, the number of orders that were exported and customer accounts that were added to Sage 200c 
2018 On Premise will be displayed.  
 

You can copy/paste the contents of the results tab to a document to consult the new records in Sage 200c 2018 
Click on the “Finish” button to save all of your export settings (order selection criteria). 
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In the DataPlug, go back to your list of orders and select the “Main Information” tab.  

Below is a preview of the “Main Information” tab where you will now see the sales order number from Sage 200c 
2018 
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15. Viewing Sales Orders Imported to Sage 200c 2018 

• View sales orders created by the DataPlug export  
In Sage 200c 2018 On Premise, go to the menu: Modules | Sales Orders Processing 

 
Below is a preview of the 2 orders exported from the DataPlug. 

 
 

Below is a preview of order No. 5288 in Sage 200c 2018 
You can see the three products in the order with their prices, excluding VAT, as well as the global value of the 10% discount, 

also excluding VAT. The Oxatis order number can be seen here in the “Customer Order No.” field.  

Delivery information and Special Instructions from the Oxatis order are shown in the reserved rows of the Sage 200c 2018 

On Premise order. 

 

 
Below is a preview of the details for the first product in the order.  
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Below is the “Delivery & invoicing” tab. 

 
 

Below is the “Payment with Order” tab. 
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16. Creating Customers in Sage 200c 2018 On Premise 

Exporting customer orders to Sage also allows you to create new customer accounts in the Sage database.  

Below is an example user from the Oxatis website that was exported to Sage 200c 2018 On Premise.  

 

The main tab in the user account. 

 
 

Below is the billing address tab in the user account. 

 
Below is the shipping address tab in the user account. 
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Exporting this customer’s order will automatically add the customer’s contact information in the B2C Customer account in 

Sage 200c 2018: 

 
 

Below are the details of the new customer created in Sage. 
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17. Currency Management 

 

To handle more than one currency, it is mandatory to have as many Oxatis websites as there are different 

currencies, as websites can only handle one currency each. It will then be necessary to import products with 

the right price and currency, and to import customers with the right currency.  

 

To do so, i. e. with the Euro currency, the product COOK/CERM/HOB, and customer NAN001 both carry the 

Euro currency. Those examples are available in the Sage 200c DemoEnvironment file.  

 

It is first necessary to have a price band in the new currency. In the Selling Price menu of the 

COOK/CERM/HOB product, fill the price band in €, for example 120 as shown in the example below.  

 

 
 

Connect with your DataPlug on an Oxatis website with your new currency, this information appears in the 

menu “Site > General Properties” in the Oxatis Back Office. 

 

 
 

Go to Connector/ link for Sage 200c /Configuration in the DataPlug menu, and select the “Languages” tab. 

The website’s currency is correctly displayed. If the website’s currency was changed, it is necessary to wait for 

the DataPlug to take the information into account, as a cache is being temporarily kept on the website.  
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In the VAT/Country list, you can leave the website’s country, and even with a different currency, you can continue to apply 
the country’s VAT rates. 
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Then, in the DataPlug’s Connector/ Link for Sage 200c /Import Item(s) menu, choose the option Import 

Items. During the Item prices mapping, it is only possible to retrieve the prices corresponding to the website’s 

currency. The product will consequently have the wanted currency.  
 

 

 

 

In the DataPlug’s Connector/ Link for Sage 200c/Import Contact(s) menu, choose the option “Import 

Contacts”. The B2C customer account has to be in the website’s currency.  
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Execute all the imports, then transfer the products to the website, and check the COOK/CERM/HOB product 

from the Back-Office, which will display the correct price.  
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Order a product with the user, which will be associated to the Euro currency. The product will be displayed in 

Euro, as shown below: 
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Download this order in the DataPlug and transfer it to Sage 200c. 

 

By looking at the generated order, you can notice that the item keeps the Oxatis website’s currency, but a change 

rate appears.   

 
The name and the price of the product are the ones from the Oxatis Order.  

The item’s currency is Euro and its change rate as filled in the Sage 200c file is shown.  
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18. Task Scheduler 

All previously documented tasks (import of Sage data, upload to Oxatis, order download and export to Sage, etc.), can be scheduled for 

automatic execution.  

 

To schedule these tasks, go to the DataPlug menu: Connectors | Link for Sage 200c | Configuration, then select the Task Scheduler tab. 

 

In this tab, you can schedule your tasks.  

 
To do so: 

✓ Enable at least one of the available tasks. 

✓ Enable at least one day of the week. 

✓ Define the start and end times for your schedule (all the time by default). 

✓ Define an execution interval in minutes (15 minutes by default). 

Once set, the tasks that have been enabled in the scheduler will be automatically executed in the background. 
 
Note: Tasks are executed in a predefined order:  

1) Sage product import to DataPlug. 
2) Sage customer/contact import to DataPlug. 
3) Images upload to Oxatis. 
4) Products upload to Oxatis. 
5) Customers/contacts upload to Oxatis. 
6) Oxatis orders download to DataPlug. 
7) Orders export from DataPlug to Sage. 

 
Below: If the scheduler is enabled, you can consult the tasks being executed and a log of previously executed tasks in the 

following menu: Connectors | Link for Sage 200c | Tasks| Ongoing tasks. 
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Below: Consultation of tasks being executed by the scheduler (enabled tasks are running in green). 

 
 

Below: Consultation of the scheduler task log.  

 
 

Below: You can close the DataPlug (from the red x in the main window, and not from the File menu) and leave it running in 

the background. An icon will appear in the Windows task bar.  
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Right-click on the DataPlug icon. A pop-up menu will appear and allow you to: 

• Open the DataPlug. 

• Quit the DataPlug. 

 

 

 


